LENESANS

Jas

7
<
W)
S
-
O

RX72M Group

Renesas Starter Kit+ for RX72M
Smart Configurator Tutorial Manual
For CS+

W
N

RENESAS 32-Bit MCU
RX Family / RX700 Series

All information contained in these materials, including products and product specifications,
represents information on the product at the time of publication and is subject to change by
Renesas Electronics Corp. without notice. Please review the latest information published by
Renesas Electronics Corp. through various means, including the Renesas Electronics Corp.
website (http://www.renesas.com).

Renesas Electronics
WWW.renesas.com Rev. 1.00 Jul 2019



Notice

1.

10.

11.
12.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Notel) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an 1/0O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V. (Max.)
and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Vis (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
o power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Smart Configurator) for RX together with the CS+ IDE to create a working project for the RSK+ platform. It is
intended for users designing sample code on the RSK+ platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK+ platform. Further details regarding
operating the RX72M microcontroller may be found in the RX72M Group Hardware Manual and within the
provided sample code. The setup procedure for the RSK+ installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX72M Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK+ Renesas Starter Kit+ for R20UT4391EG
hardware. RX72M User’s Manual
Tutorial Manual Provides a guide to setting up RSK+ Renesas Starter Kit+ for R20UT4384EG
environment, running sample code and RX72M Tutorial Manual
debugging programs.
Quick Start Guide Provides simple instructions to setup the RSK+ | Renesas Starter Kit+ for R20UT4385EG
and run the first sample. RX72M Quick Start Guide
Smart Configurator Provides a guide to code generation and Renesas Starter Kit+ for R20UT4386EG
Tutorial Manual importing into the CS+ IDE. RX72M Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK+. Renesas Starter Kit+ for R20UT4390EG
RX72M Schematics
Hardware Manual Provides technical details of the RX72M RX72M Group Hardware RO1UHO804EJ
microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi§ is a Digilent Pmod™ qupatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK+ Renesas Starter Kit+
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE
Smart Configurator to create a working project for the RSK+ platform.

1.2 Features

This RSK+ provides an evaluation of the following features:

« Project Creation with CS+

« Code generation using the Smart Configurator.

o User circuitry such as switches, LEDs and a potentiometer

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT4386EG0100 Rev. 1.00 Page 8 of 69
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Renesas Starter+ Kit for RX72M 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator for the RX family
together with the CS+ IDE to create a working project for the RSK+ platform. The tutorials help explain the
following:

Project generation using the CS+

Detailed use of the Smart Configurator for CS+
Integration with custom code

Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
o ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
e ‘Debug’ is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options (level two) and no ‘Outputs debugging information’
options not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

R20UT4386EG0100 Rev. 1.00 Page 9 of 69
Jul.31.19 RENESAS




Renesas Starter Kit+ for RX72M

3. Project Creation with CS+

3. Project Creation with CS+

3.1

Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX72M
MCU, ready to generate peripheral driver code using Smart Configurator. This project generation step is
necessary to create the MCU-specific project and debug files.

3.2

Creating the Project

To use the program, start CS+:
Windows™ 7: Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)’ icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

CS+ will show the Start Page. Use
the ‘GO’ button to Create a New
Project.

Create New Project

A new project can be created.
A new project can also be created by reusing the file configuration registered to an existing project.

In the ‘Create Project’ dialog, select
‘RX’ from the ‘Microcontroller’ pull-
down.

In the ‘Using Microcontroller’ list
control, scroll down to ‘RX72M’ and
expand the tree control by clicking ‘+'.
Select ‘R5F572MNDxBD(224pin)’.

Ensure that in the ‘Kind of project’ pull-
down, ‘Application(CC-RX)’ is selected.

Choose an appropriate name and
location for the project, then click
‘Create’.

Note: this tutorial assumes the project
is named and located at the place
shown opposite.

If the folder entered cannot be found a
‘Question’ dialog will be displayed;
click ’Yes'.

Microcontroller: Rx ~

Using microcontroller:

5, (Search microcontroller) Update.

W R5F572MDHxFC{176pin) | | Product Name:R5F572MNDxBD
M R5F572MDHxFC_DUAL(176pin gnc:ip Egm swzegg’twals%'mTe
t 4 R5F572MNDxBD 224pin) | o N DL !
5F572MNDED. DUAL(224pin Additional Information:Package=PLBGO224GA-A
% R5F572MNDBG(176pin)
3% R5F572MNDxBG_DUAL(176pin
% R5F572MNDxFC(176pin)
e vanin.. e

v

Kind of project Application{CC-RX) -
Project name: SC_Tutorial
Flace: C\Workspace o

Make the project folder

C:\Workspace\SC_Tutonal\SC_Tutonial.mip)

[ Pass the file composition of an existing project to the new project

Browse...

Create Cancel Help

CS+ will create the blank project with
the standard project tree. A ‘Smart
Configurator’ node may also be
shown, if previously enabled.

™ SC Tuterial - CS+ for CC - [Property]

File Edit Wiew Project Build Debug Tool Window Help

Sosot FE@ X BE 0 RS A >
S ) R G @ S| S g solution List
(3} | Project Tree X Property
= =
E : O 2@ i r Property
=|| B-_13 5C Tutorial (Project
z L
E R5F572MNDxED (Microcontroller) Version
= “i:Smart Configurator (Design Tool) v Smart configurator selfing
4‘ CC-RX (Build Tool) Smart Configurator for RX executable file path

g2, RX Simulator (Debug Tool)
. ’\\" Program Analyzer (Analyze Tool)
=-[3 File
& dbsctc
= ‘ﬂ intprg.c
ﬂ resetprg.c
‘d shrk.c
£ SC_Tutorial.c
- ﬂ wvecttbl.c
-] iodefine.h
b sbrich
- U stacksct.h
U typedefine.h
U vect.h

R20UT4386EG0100 Rev. 1.00
Jul.31.19



Renesas Starter Kit+ for RX72M 4. Smart Configurator Using the CS+

4. Smart Configurator Using the CS+

4.1 Introduction

The Smart Configurator for the RX72M has been used to generate the sample code discussed in this
document. Smart Configurator for CS+ is a tool for generating template ‘C’ source code and project settings
for the RX72M. When using Smart Configurator, it provides the user with a visual way of configuring the
target device, clocks, software components, hardware resources and interrupts for the project. Thereby
bypassing the need in most cases to refer to sections of the Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called SC_Tutorial. A fully
completed Tutorial project is contained in the RSK+ Web Installer
(https://www.renesas.com/rskrx72m/install/cs) and may be imported into CS+ by following the steps in the
Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these moanddules to perform A/D conversion. Results
are displayed via the virtual COM port in a terminal program and also on the PMOD display connected to the
RSK+.

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator.

R20UT4386EG0100 Rev. 1.00 RENESAS Page 11 of 69
Jul.31.19
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Renesas Starter Kit+ for RX72M 4. Smart Configurator Using the CS+

4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: CS+.
You can download the latest document from: https://www.renesas.com/smart-configurator.

Smart Configurator will start up by double clicking on “Smart Configurator (Design Tool)” in the project tree.
The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

Smart Configurator - X
File Window Help
Jmll~} DR
& SC_Tutorialscfg 22 = B || & MCUPackage % = g
Overview information % & =] i »
- General information @ 0

This editer allows you to medify the settings stored in configuration file (:scfg)

Board

Allow board and device selection

Application under
Clocks development
Allow clock configuration « components

Middleware
Components Device d 200006¢
driver RTOS

e

Allow software component selection and configuration
= Pins

Pins

Allow general pin configuration and pin cenfiguration for selected software compenent

Interrupt

Allow general interrupt configuration and interrupt configuration for selected software component

~ Current Configuration

Selected board/device: RSF572MNDxBD (ROM size: 4MB, RAM size: 1TMB, Pin count: 224)

Selected components:

Overview| Board| Clocks| Components| Pins| Interrupts » Legend

& Console &2 S b B o 2~ v = B ||[E Configuration Problems &%

Smart Configurator Output Oitems
M@58@0081: Pin K1 is assigned to CLKOUT25M || Deseription
M@5600001: Pin J1 is assigned to EXTAL

M@58000@1: Pin HL is assigned to XTAL v

Type

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project that builds and runs without error.

R20UT4386EG0100 Rev. 1.00 :{EN ESNS Page 12 of 69
Jul.31.19


https://www.renesas.com/smart-configurator

Renesas Starter Kit+ for RX72M 4. Smart Configurator Using the CS+

4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-2.

gt 5C_Tutorial.scfg 23

Device selection

Device selection

Board:  iCustem User Board P

Device: | R3F372MMDxBD

OverviewlBoardIClocks Compenents | Pins | Interrupts

IGR=

B3 3

Figure 4-2 The ‘Board’ tabbed page

4.31 Board configuration

Make sure that ‘Custom User Board’ is selected for the ‘board:’.

8% SC_Tutorial.scfg 53

Device selection

Device selection

Board: ICustom User Board VI

Device: | R5F372MMNDxBD

Figure 4-3 Select board

R20UT4386EG0100 Rev. 1.00 RRENESAS
Jul.31.19
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Renesas Starter Kit+ for RX72M 4. Smart Configurator Using the CS+

4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected to
‘r_bsp_config.h’ file in ‘Smart Configurator\r_config’ of project tree.

441 Clocks configuration

Figure 4-5 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on-board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-4.

i,?,!‘? *SC. Tutorial.scfg 2 = 7
Clocks configuration . % &
.
vee: | 33 )
| PLL circuie

SCKER (FCLKE0]) FlashlF clock [FCLK)

Frequency Division:
) Anensy Xl - 60.0 (MHz)
x1 -
3 ol SCRER (leLxiz-0n System clock (LK)
| Main clack Frequency Mutiplication: '
Oscilla ; ons x1 = 2400 (MHz)
scillztion source: | Resonator ¥
08 - SCKCR (PCLKAR:0])
prequency [ . CR (PCLKAR: Peripheral module clock (PCLKR)
P LA I 1200 (MHz)
Oscillation wait time: L
SCKCR {PCLKB{3:0]) Peripheral module clock (PCLKE)
9950 {us) actual value: 10000.000 us S 4 (M)
.0 (MHz)
SCKCR (PCLKC[3:0]) Peripheral madule clock (PCLKC)
x4 - §0.0 (MHz)
Sub-clock y
Ty SCKCR [PCLKD[:0]) Peripheral module clock (PCLKD)
x4 60.0 (MHz)
SCKCR (BCK[E:0 « clock (BCLK
Ll (BCK[:0) External bus clock (BCLK)
X113 - 200 (MHz)
BCKCR (BCLKDIV)
— |
/] SCKCR2 (UCKE:0) SDRAM clock (SDCLK)
PPLL circuit s -
HOCO clack Erzquency Divisian =8 USB clack JUCLKICACUCLE
PPLLCRS (PPLCKI3:0) . :
x1/2 - 480 (MHz)
L Xz -
Frequency Multiplication:

250 - ESCCLK
100.0 (MHz)
LoCo clock

CLKOUT25M/CACCLKOUTZSM

——— x1/8 v ——— 350 (MHz)
-
& CKOCR (CKODIV20]) CLKOUT pin
L i =
IWDT-dedicated clock 1
CANMCLK/CACMELK
24 (MHz)
« »

Overview BoardlCIocksI Components | Pins | Interrupts

Figure 4-4 The ‘Clocks’ tabbed page
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

4.5 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The ‘Components’ page
allows the user to select and configure software components.

§8% *SC_Tutorial.scfg &3

Software component configuration

Components = }:D 52
%
type filter text
v [= Startup
v [= Generic
& rbsp

"Overview | Board | Clocks I Componentsl Pins| Interrupts

Figure 4-5 Components page

451 Add a software component into the project

Smart Configurator supports four types of software components: Startup, Drivers, Middleware and Application.
In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ & icon.

§8% *SC_Tutorial.scfg 53
Software component configuration

Components Jlebecd = -

=

type filter text

w [ Startup
~ [= Generic
& rbsp

Figure 4-6 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Mew Component

Software Component Selection

Select component from those available in list

Type All ~
Function A
Filter
iddleware
Application
Fad £y 1 N

Figure 4-7 Add a Software component

(2)
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

4.5.2 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as
timers in de-bouncing of switch interrupts.
Select ‘Compare Match Timer’ as shown in Figure 4-8 below then click ‘Next’.

MNew Component

Software Component Selection -|£-

Select component from those available in list

Type Drivers ~
Function |All o
Filter |
r

Components Type Version Q

B 8-Bit Timer Code Generator 160

B Buses Code Generator 160

7 Clock Frequency Accuracy Me...  Code Generator 1.6.0

£ Compare Match Timer Code Generator 1.8.0 |

£ Complementary PWM Mode Ti... Code Generator 160

## Continuous Scan Mode 51280 Code Generator 1.60

B CRC Caleulator Code Generator 160

B D/A Converter Code Generator 1.6.0

## Data Operation Circuit Code Generator 160 %

Mmoo, - P -~ F arn

< >
Show only latest version
Description

This software component provides configurations for 16-bit/32-bit timer with

module CMT/CMTW and can generate interrupts at set intervals.

Download mere software components

Configure general settings...

@ <Back | Net> |[ Ensn | Cancel

Figure 4-8 Select Compare Match Timer

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTO0’ as shown in Figure 4-9

below then click ‘Finish’.

MNew Component

Add new configuration for selected component _E

Compare Match Timer
Configuration name: |Config_CMTWO |

Resource: CMTWO ~
CMTWO
CMTW1 l
CMT2
CMT3

® < Back Mext = Cancel

Figure 4-9 Select Resource - CMT0
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Renesas Starter Kit+ for RX72M 4. Smart Configurator Using the CS+

In ‘Config_ CMTQ’, configure CMTO as shown in Figure 4-10. This timer is configured to generate a high

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

Components i o= = Configure
% Count clock setting
- ® PCLK/E (O PCLK/32 (O PCLK/128 O PCLK/512
type filter text
v (= Startup R Compare match setting
v [ Generic Interval value |1 I Ims VI (Actual value: 1)
-l Register value (CMCOR) (7499 |
w [= Drivers
v [= Timers Compare match interrupt (CMID)
= Config_CMTO g :
&' Lonfig. Priority [ieveiio v

Figure 4-10 Config_CMTO setting

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT1’ as shown in Figure 4-11 below then click ‘Finish’.

Mew Component

Add new configuration for selected component |

Compare Match Timer

Configuration name: Config_CMTWO |

Resource: CMTWO ~
CMTWOD
CMTW1
CMTO

® < Back Next > Cancel

Figure 4-11 Select Resource — CMT1

Navigate to the ‘Config_CMT1’ and configure CMT1 as shown in Figure 4-12. This timer is configured to

generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

Components A B = Configure
% = Count clock setting
O PCLK/S ® PCLK/32 (O PCLKA28 (O PCLK/S12
e [©raz]
v (= Startup = Compare match setting
v [= Generic Interval value IZO I Ims VI (Actual value: 20)
W o Register value (CMCOR) [37490 |
w = Drivers
v (= Timers Compare match interrupt (CMIT)
& Config_CMTO e g T
- P [Level 10 e
& Config_CMT1 oty L |

Figure 4-12 Config_CMT1 setting

R20UT4386EG0100 Rev. 1.00
Jul.31.19

RRENESAS

Page 17 of 69



Renesas Starter Kit+ for RX72M 4. Smart Configurator Using the CS+

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-13 below then click ‘Finish’.

Mew Component

Add new configuration for selected component 'Hj-

Compare Match Timer

Configuration name: Config_CMTWO |

Resource: CMTWO ~

CMTWO
CMTW1
CMTO
CMT1

CMT3 l

® < Back Next > Cancel
Figure 4-13 Select Resource — CMT2

Navigate to the ‘Config_ CMT2’ and configure CMT2 as shown in Figure 4-14. This timer is configured to
generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

Components i oo = Configure
% = Count clock setting
O PCLK/E OPCLK/32 OPCLK/128 (@ PCLK/512

type filter text

Compare match setting

v [= Startup A
v [= Generic Interval value IZOD I Ims VI (Actual value: 200.004267)
& rbsp Register value (CMCOR) (23437 |
w = Drivers
w [= Timers Compare match interrupt (CMI2)
& Config_CMTO e g T
P iLevel 10 P
& Config_CMT1 omy fLeve N
& Config_CMT2

Figure 4-14 Config_CMT2 setting
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

4.5.3 Interrupt Controller

Referring to the RSK+ schematic, SW1 is connected to IRQ13(P45) and SW2 is connected to IRQ12 (P44).
SW3 is connected to IRQ15(P07) and ADTRGON. This tutorial uses ADTRGOnN, which will be configured later
in §4.5.7.

Click the ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
ure 4-15 then click ‘Next'.

Select ‘Interrupt Controller’ as shown in Fig

MNew Component

Software Component Selection

Select component from those available in list

B Phase Counting Mode Timer
o~ .o
<

Type IDrwers e I
Function | All 2
Filter | |

Components Type Version (e

B Event Link Controller Code Generator 1.5.0

B General PWM Timer Code Generator 140

B Group Sean Mode 5124D Code Generator 160

B8 12C Master Mode Code Generator 1.6.0

4 12C Slave Mode Code Generator 1.6.0

H Interrupt Controller Code Generator 1.8.0 I

B Low Power Consumption Code Generator 1.8.0

B Normal Mode Timer Code Generator 160

Code Generator 180

Show only latest version

Description

Interrupt Controller configures the interrupt requests generated by [CU: Software
interrupt, NM| pin interrupt and IRQ External pin interrupts.

Download more software components

Configure general settings...

@ < Back Einish |

| Ned>»

Cancel

Figure 4-15 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-16

below then click ‘Finish’.

New Component

Add new configuration for selected component

Interrupt Controller

Configuration name: Config_ICU |
Resource: ICU ~
® < Back Mext = Cancel

Figure 4-16 Select resource — ICU
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-17

below.

Components B @

type filter text

v [= Startup -~
v [= Generic
& rbsp
~ [= Drivers
v [= Interrupt
& Config_ICU
v = Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

Configure

Software interrupt setting
[ Software interrupt
[ Software interrupt 2

MMI pin interrupt setting
I WM pin interrupt

IRC setting
Cirao

IRCH1 setting
Oira1

IRC2 setting
Oira2

IR setting
ira3

IRC4 setting
CJiro4

IR setting
iras

IR setting
[CJiras

IRQ setting

Oirar

IRQE setting
[1iRQ8

IRQQ setting
[1IRQ9

IRQ10 setting
[IirQ10

IRQ1 setting
CIRQ1

IRQ12 setting
Elraiz

IRQ13 setting
Edrais

IRQ14 setting
[IIrQ14

IRQ1S setting
[IIrQ15

Detection type

Level 15 (highest)

Falling edge

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 13 (highest)

Low level

Level 13 (highest)

Low level

Level 13 (highest)

Low level

Level 13 (highest)

Low level

Level 13 (highest)

Low level

Level 13 (highest)

Low level

Level 13 (highest)

Detection type |Falling edge o Dig

Priority |Level 13 (highest) ~

Dig

Priority |Level 13 (highest) ~

Low level

Level 13 (highest)

Low level

Level 13 (highest)

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Figure 4-17 Config_ICU setting
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

454 Ports

Referring to the RSK+ schematic, LEDO is connected to P42, LED1 is connected to PHO, LED2 is connected
to PN4 and LED3 is connected to P85. PCS5 is used as one of the LCD control lines, together with P02, PJ1

and PL1.

Click the ‘Add component’ & icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Select ‘Ports’ as shown in Figure 4-18 then click ‘Next'.

MNew Component

Software Component Selection e
Select component from those available in list .H:"
Type IDrwers VI
Function | All 2
Filter | |

Components Type Version (e
B Interrupt Controller Code Generator 1.8.0

## Low Power Consumption Code Generator 180

B Normal Mode Timer Code Generator 160

8 Phase Counting Mode Timer Code Generator 1.8.0

H Port Output Enable Code Generator 1.6.0

H Ports Code Generator 1.8.0 I
B Programmable Pulse Generator ~ Code Generator 1.20

B PWM Mode Timer Code Generator 160

B Real Time Clock Code Generator 140

o e s : S S 57
< >

Show only latest version

Description

pull-ups are also supported.

This software component provides cenfigurations for General Purpose Input/Output.
Commoeon features such as reading, writing, and setting the direction of ports and
pins can be configured. Enabling features such as open-drain outputs and internal

Download more software components

Configure general settings...

® < Back I

Ned> ||

I Cancel

Figure 4-18 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-19

below then click ‘Finish’.

MNew Component

Add new config ion for sel d p . ]
Ports
Caonfiguration name: | Config_PORT |
Resource: PORT S
® < Back Next > Cancel

Figure 4-19 Select resource — PORT
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

Tick the tickboxes for ‘PORT0’, ‘PORT4’, ‘PORTE’, ‘PORTC’, ‘PORTH’, ‘PORTJ’ , ‘PORTL" and ‘PORTN’ as

shown in Figure 4-20 below.

Components = :.é:p »  Configure
= = Port selection
type filter text
v (= Startup ~ 1PORTO
w [~ Generic
@ rbsp [1poRT2
w (= Drivers
v = Ir?_i_:errupt. [ZIPORT4
& Config_ICU
~ = I/0Ports C]PoRTE
& Config_ PORT
v = T.i_r_'ners [Z1PORTE
& Config_CMTO
& Config_CMT1 []PORTA
& Config_CMT2
[~]PORTC
[C1PORTE
o [C1PORTG
[] PORT)
[]PORTL
[] PORTHM

PORTO PORT4 PORT8 PORTC PORTH PORT

C1PORT1
C1PORT3
[ 1PORTS
C1PORT?
[JroRTS
[ PORTE
CJPORTD
C1PORTF
C1PORTK
C1PORTM

[JPORTQ

PORTL PORTN

Figure 4-20 Select Port selection

Navigate through each of the ‘PORTX’ tabs, configuring these four I/O lines and LCD control lines as shown in
Figure 4-21, Figure 4-22, Figure 4-23, Figure 4-24, Figure 4-25, Figure 4-26, Figure 4-27 and Figure 4-28
below. Ensure that the ‘Output 1’ tick box is checked, except for PL1 under the ‘PORTL’ tab. Start with the

) )
PORTO' tab.
Components B ®E3- Configure
. Port selection | PORTO | PORT4 PORTE PORTC PORTH PORT) PORTL PORTN
type filter text
v [ Startup -~ [ apply to all
v & Generic Unused GPIO In Out Pull-up | CMOS output Output 1
& rbsp
v [= Drivers oo
v (= Interrupt
& Config_ICU ®Unused GPI0. Oln O 0ut [Pull-up | CMOS output Output 1 |Normal drive output
v [= /O Ports
& Config_PORT POl
v & Timers @Unused GPI0. Oln - O 0ut  Pull-up | EMOS output Output 1 |Mormal drive autput
& Config_CMTO
§ ==
& Config |
(OUnused GPIO O In Pull-up CMOS output e MNormal drive output s
P03
@ Unused GRIO O'in 0wt [JPull-up CMOS output Qutput 1
P05
@ Unused GPIO Oiin (O Out DPuH-up CMOS output Output 1
PO7
@ Unused GPIO OIn O 0ut  [JPull-up CMOS output Qutput 1
Figure 4-21 Select PORTO tab
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

Select ‘PORT4’ tab.

Components = v Configure
- Port selection PORTO PORTC PORTH PORT) PORTL PORTN
type filter text
w [ Startup [ Apply to all
v & Generic Unused GPIO In Out Pull-up  |CMOS output Output 1
o rbsp
w 2= Drivers 4D
v [ Interrupt
*',' Config_ICU @® Unused GPIO (O)in (O Qut DPuH—up CMOS output Output 1
v (= /0 Ports
& Config_PORT P41
v BT.\rmer; ®UnusedGPIO OIn Oout  [JPull-up | CMOS output Output 1
& Config_CMTOD
'f__ Config_CMT1 P42
& Config_CMT2
(O Unused GPIO Pull-up | CMOS output ~
P43
@®Unused GPIO (Oiin (O Out DPuH-up CMOS output Output 1
P44
®Unused GPI0 Oin O out DPuH-up CMOS output Output 1
P45
®Unused GPIO Oin O 0wt [JPull-up CMOS output Output 1
P46
®Unused GPIO Oin QO out  [JPull-up CMOS output Output 1
P47
®UnusedGPIO Oin O0ut  [JPull-up | CMOS output Output 1
Figure 4-22 Select PORT4 tab
‘
Select ‘PORTS tab.
Components = v Configure
T - Port selection  PORTO PORT4 PORTC PORTH PORT) PORTL PORTN
type filter text
v [ Startup ~ [ Apply to all
v & Generic Unused GPIO In Out Pull-up  [CMOS output Output 1
o rbsp
w22 Drivers peo
v [ Interrupt
& Config_ICU ®Unused GPI0. Oin 00wt [JPull-up | CMOS output Output1 | Normal drive output
v [= |/O Ports
& Config_PORT P21
v e T.\Vmer; @®Unused GPIO. O'n O 0wt [JPull-up CMOS output Output 1 Normal drive output
& Config_CMTO
'f__ Config_CMT1 paz
& Config_CMT2
®Unused GPIO Olin O 0wt [JPull-up CMOS output Output 1 Normal drive output
P83
@®UnusedGPIC O'in O0ut  [Pull-up CMOS output Output 1 Normal drive output
paa
®Unused GPIO OIn - O 0Out  [JPull-up CMOS output Output 1 Normal drive output
P85
O Unused GPIO Pull-up CMOS output ~ MNormal drive output ~
P86
@ Unused GPIO Oin - O 0out  [JPull-up CMOS output OQutput 1
pP&7
@ Unused GPIO Oin - O 0wt [JPull-up CMOS output Output 1 High-drive output
Figure 4-23 Select PORTS tab
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

Select ‘PORTC’ tab.

Components = v Configure
- Port selection  PORTO0 PORT4 PORTSPORTH PORT) PORTL PORTN
type filter text
v [ Startup ~ [Japply to all
v & G._enenc Unused GPIO In Out Pull-up | CMOS output Output1 | Normal drive output
o rbsp
w 2= Drivers PO
v [ Interrupt
& Config_ICU ®Unused GPIO Oin O 0wt [JPull-up CMOS output Qutput 1 Normal drive output
v @ /O Ports
& Config_PORT PC1
v (= Timers ®Unused GPIO Oin O0ut  [JPull-up | CMOS output Output1 | Normal drive output
& Config_CMTOD
& Config_CMT1 P2
& Config_CMT2
®Unused GPIO Olin O 0wt [JPull-up CMOS output Output 1 Normal drive output
PC3
@®UnusedGPIC Oin O0ut  [Pull-up CMOS output Output 1 Normal drive output
pPC4
@®Unused GPIO. O'n O 0wt [JPull-up CMOS output Output 1 Normal drive output
PC5
O Unused GPIO Pull-up CMOS output ~ MNormal drive output ~
PCE
@ Unused GPIO Oin - O 0out  [JPull-up CMOS output Output 1 Normal drive output
PC7
@ Unused GPIO Oin - O 0wt [JPull-up CMOS output Output 1 Normal drive output
Figure 4-24 Select PORTC tab
‘ ’
Select ‘PORTH' tab.
Components = v Configure
T - Port selection  PORT0 PORT4 PORTZ PORTC H | PORT) PORTL PORTN
type filter text
v [ Startup ~ [ Apply to all
v & G._enenc Unused GPIO In Out Pull-up | CMOS output Output1 | Normal drive output
& rbsp
w22 Drivers PHD
v [ Interrupt
& Config_ICU (O Unused GPIO Pull-up CMOS output ~ Mormal drive output ~
v [= |/O Ports
& Config_PORT PH1
v e T.\Vmer; @®Unused GPIO. O'n O 0wt [JPull-up CMOS output Output 1 Normal drive output
& Config_CMTO
& Config_CMT1 PHZ
& Config_CMT2
®Unused GPIO Olin O 0wt [JPull-up CMOS output Output 1 Normal drive output
PH3
@®UnusedGPIC O'in O 0wt [Pull-up CMOS output Output 1 Normal drive output
PHA
®Unused GPIO OIn - O 0Out  [JPull-up CMOS output Output 1 Normal drive output
PH3
®Unused GPIO Olin O 0wt [JPull-up CMOS output Output 1 Normal drive output
PHE
@ Unused GPIO Oin - O 0out  [JPull-up CMOS output Output 1 Normal drive output
PHT
@ Unused GPIO Oin - O 0wt [JPull-up CMOS output Output 1 Normal drive output
Figure 4-25 Select PORTH tab
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Renesas Starter Kit+ for RX72M

4. Smart Configurator Using the CS+

Select ‘PORTJ tab.

Components = v Configure
. Port selection PORTO PORT4 PORTE PORTC PORTH-PORTL PORTH
type filter text
v [ Startup ~ [ apply to all
v & G_ener\( Unused GPIO In OQut Pull-up CMOS output Output 1
o rbsp
w 2= Drivers I
w [ Interrupt
*' Config_ICU @ Unused GPIO Oin QO out  [JPull-up CMOS output OQutput 1 MNormal drive output
v [&= |/O Ports
& Config_PORT P11l
v & T.\_mars (O Unused GPIO Pull-up | CMOS output ~ Normal drive output ~
& Config_CMTO
& Config_CMT1 -
& Config_CMT2
@ UnusedGPIO Oin Oout [Pull-up CMOS output Output 1 Normal drive output
k]
®Unused GPI0 Oin O out DPuH-up CMOS output Output 1
RI5
@®Unused GPIO Oin O out DPuH-up CMOS output Qutput 1
Figure 4-26 Select PORTJ tab
€ ’
Select ‘PORTL tab.
Components =] ::: =  Configure
W Port selection  PORTO PORT4 PORT8 PORTC PORTH PORTI -
type filter text
w [= Startup - [Apply to all
vE anar\c Unused GPIO In Out Pull-up CMOS output Output 1 MNormal drive output
W& rbsp
~ [= Drivers PLO
v [ Interrupt
& Config_ICU ®Unused GPIO OIn O0ut  [JPull-up | CMOS output Output1 | Normal drive output
v [= /O Ports
& Config_PORT PLI
v & T_‘_"‘E“ (O Unused GPIO Pull-up | CMOS output ~| [OJOutput1 | Normal drive output v
& Config_CMTO
& Config_CMT1 pL2
& Config_CMT2
®Unused GPIO Oin - O 0out  [JPull-up CMOS output Output 1 Normal drive output
PL3
@ Unused GPIO OIn O 0Out  [JPull-up CMOS output Output 1 Normal drive output
PL4
®UnusedGPIC O'in O 0wt [Pull-up CMOS output Output 1 MNormal drive output
PL3
@Unused GPIO. O'n O 0wt [JPull-up CMOS output Output 1 Normal drive output
PLE
®Unused GPIO Oin - O 0wt [JPull-up CMOS output Output 1 Normal drive output
PL7
®Unused GPIO Oin - O 0out  [JPull-up CMOS output Output 1 Normal drive output
Figure 4-27 Select PORTL tab
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4. Smart Configurator Using the CS+

Select ‘PORTN'’ tab.

-+

Components 2B =

[

I -
T

e

type filter text

w [ Startup ~
v [= Generic
& rbsp
w 2= Drivers
w [ Interrupt
& Config_ICU
~ [ /O Ports
& Config_PORT
v = Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

Configure

Port selection PORTO PORT4 PORTS PORTC PORTH PORT) PORTL | PORTH

[ apply to all
Unused GPIO

PMND
®) Unused GPIO

PN1
® Unused GPIO

PN2
® Unused GPIO

PN3
(® Unused GPIO

P4
(O Unused GPIO

PN5
®) Unused GPIO

Oin

Qut Pull-up
Oout  [JPull-up
Oout  [Pull-up
Oout O Pull-up
Qou [ Pull-up

o

Pull-u

Qout  [JPull-up

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

Output 1

OQutput 1

Output 1

Qutput 1

Output 1

Qutput 1

MNormal drive output

MNormal drive output

MNormal drive output

Normal drive output

Mormal drive output

Mormal drive output

MNormal drive output

Figure 4-28 Select PORTN tab
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4. Smart Configurator Using the CS+

4.5.5 SCI/SCIF Asynchronous Mode

In the RSK+RX72M, SCI6 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as

shown in the schematic.

Click the ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SCI/SCIF Asynchronous Mode’ as
shown in Figure 4-29 then click ‘Next’.

MNew Component

Software Component Selection —
Select component from those available in list .dj.
Type IDrwers VI
Function | All v
Filter | |

Components = Type Version Ce)
HE PWM Mode Timer Code Generator 1.6.0

E Real Time Clock Code Generator 1.4.0

SCI/SCIF Asynchronous Mode Code Generator 1.6.0 |

B SCI/SCIF Clock Synchronous M. Code Generator 1.6.0

B Single Scan Mode 5124D Code Generator 180

B Smart Card Interface Mode Code Generator 160

R SPI Clock Synchronous Mode Code Generator 1.60

8 SPI Operation Mode Code Generator 160

EE Voltage Detection Circuit Code Generator 180 o
o - PR 2 arn

< >
Show only latest version
Description

This software component provides configurations for SCI{SCIF) clock synchronous
mode.

Download more software components

Configure general settings...

® < Back I Mext > I I Finish I Cancel

Figure 4-29 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as

shown in Figure 4-30 below.

Figure 4-30 Select Work mode — Transmission/Reception

@ < Back Next > e

New Component

Add new configuration for selected component = ]

SCIfSCIF Asynchronous Mode

Configuration name: Config_SCID |

Work mode: Transmission i

Resource:

Transmission

ult or lransmission
Multi-processor Reception

Multi-processor Transmission/Reception
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4. Smart Configurator Using the CS+

In ‘Resource’, select ‘SCI6" as shown in Figure 4-31 below.

Ensure that the ‘Configuration name’ is set to ‘Config

MNew Component

Add new configuration for selected component

SCI/SCIF Asynchronous Mode

Configuration name: Config_SCID

Work mode: Transmission/Reception

Resource: SClo

SCIo
sCn
sCi2
SCI3
SCI4
5CI5

SCI7
sCI8
sCl9
sCno
sCim
sCh2

® TR

Cancel

Figure 4-31 Select Resource — SCI6

Mew Component

Add new configuration for selected component

 SCI6’ as shown in Figure 4-32 below then click ‘Finish’.

SCI/SCIF Asynchronous Mode

Configuration name: IConfig_SCIE

Work mode: Transmission/Reception

Resource:

SCI6

®

Cancel

Figure 4-32

Ensure Configuration name - Config_SCI6
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Renesas Starter Kit+ for RX72M 4. Smart Configurator Using the CS+

Configure SCI6 as shown in Figure 4-33. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD6 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

Components =l Configure
+ = Start bit edge detection setting
. (O Low level on RXD6 pin (®) Falling edge on RXD6 pin
type filter text
v & Startup 5 Data length setting
v (= Generic (9 bits (®) 8 bits (O 7 bits
i & rbsp Parity setting
¥ BE:NIET - @) MNone () Even O 0dd
~ ntermup
& Config_ICU Stop bit length setting
v = |.*t0 Ports @ 1 bit (0 2 bits
& Config PORT
+ (= Communications Transfer direction setting
& Config_SCI6 (®) L5B-first () MSB-first
L 'T(_l_mcers fia CMTO Transfer rate setting
onfig_
*" Config_CMT1 Transfer clock Internal clock e

& Config CMT2 16 cycles for 1-bit period

Bit rate w|  (bps) (Actual value: 9615.385, Error: 0.16%)

[[]Enable modulation duty correction

SCK6 pin function SCK6 is not used ~

Noise filter setting
[] Enable noise filter

Clock signal divided by 1 60000000
Hardware flow control setting
@ None O cTs62 (O RTSE2
Data match detection setting
[JEnable data match detection
0x00

Data handling setting

ac Transmit data handling Data handled in interrupt service routine o
Receive data handling Data handled in interrupt service routine ~
Interrupt setting
TXIE priority Level 15 (highest) ~
RXI& priority Level 15 (highest) o
Enable reception error interrupt (ERIG)
TEI&, ERIG pricrity (Group BLO) Level 15 (highest) ~
Callback function setting
[ Transmission end Reception end Reception error

Figure 4-33 Config_SCI6 setting
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4.5.6 SPI Clock Synchronous Mode

In the RSK+RX72M, SCI8 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in

the schematic. Click the ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as
shown in Figure 4-34 then click ‘Next'.

MNew Component

Software Component Selection
Select compenent from those available in list tlj.
Type IDrlver; ~ I
Function All ~
Filter | |
Components Type Version 2
8 Real Time Clock Code Generator 140
ESCVSCIFAsynchronous Mode Code Generator 1.60
## 5CI/SCIF Clock Synchronous M. Code Generator 160
$Smg|e Scan Mode 512AD Code Generator 1.80
7 Smart Card Interface Mode Code Generator 1.6.0
5P| Clack Synchronous Mode Code Generator 1.6.0 |
£ SPI Operation Mode Code Generator 160
## Voltage Detection Circuit Code Generator 160
$Watchdog Timer Code Generator 160 v
< >
Show only latest version
Description
This component provides clock synchronous operation of R5P| or 5Cl (Simple SPI
bus). It includes 4 transfer medes: Slave transmit/receive, Slave transmit, Master
transmit/receive and Master transmit.

Download more software components

Configure general settings...

® < Back I Mext » I | Finish | Cancel

Figure 4-34 Select SPI Clock Synchronous Mode

In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown
in Figure 4-35 below.

MNew Component

Add new configuration for selected component |

5PI Clock Synchronous Mode

Configuration name: | Config_RSPID |

Operation: Slave transmit/receive ~

Slave transmit/receive
Slave transmit only

Resource:

@ < Back Mext = Cancel

Figure 4-35 Select Operation — Master Transmit
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In ‘Resource’, select ‘SCI8 as shown in Figure 4-36 below.

MNew Component

Add new configuration for selected component -E-

5PI Clock Synchronous Mode

Configuration name: Config_RSPID |

Operation: Master transmit only ~

Resource: RSPID ~

RSPID
RSPI
RSPI2
SClo
sCi
sCi2
SCI3
SCl4
SCIs
SCl6
SCI7
SClg
SCio
SCIm
sCI2

® < Back Next > Cancel
Figure 4-36 Select Resource — SCI8

Ensure that the ‘Configuration name’ is set to ‘Config SCI8’ as shown in Figure 4-37 below then click ‘Finish’

Mew Component

Add new configuration for selected component 'Ha'

SPI Clock Synchronous Mode

Configuration name: IConfig_SCIS I
Operation: Master transmit only ~
Resource: SCI8 e

® < Back Next = Cancel

Figure 4-37 Ensure Configuration name - Config_SCI8
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Configure SCI8 as shown in Figure 4-38. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 15000 kbps. All other settings remain at their defaults.

Components B e Configure
% = Transfer direction setting
type filter text () LSE-first (@) MSB-first
v = Startup * Data inversion setting
v & G._enen( ® Normal O Inverted
& rbsp
v (& Drivers Transfer speed setting
w [ Interrupt
& Config_ICU Transfer clock Internal clock (SCK3 pin functions as clock output pin) ~
v = 1/O Ports ; 5 ar
.{- Config_PORT Bit rate 15000 (kbps)  (Actual value: 13000, Error: 0%)
v [ Communications [ Enable modulation duty correction
& Config_5CI6
& Config_5CI3 Clock setting
v e T_\_mers [JEnable clock delay [JEnable clock polarity inversion
@& Config_CMTO
@ Config CMT1 Data handling setting
& Config_CMT2
Transmit data handling Data handled in interrupt service reutine v

Interrupt setting
TXIB priority Level 15 (highest) ~
TEIB priority (Group ALO) Level 15 (highest) ~

Callback function setting

Transmission end

Figure 4-38 Config_SCI8 setting
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4.5.7 Single Scan Mode S12AD

We will be using the S12AD in Single Scan Mode on the ANO0OO input, which is connected to the RV1
potentiometer output on the RSK+. The conversion start trigger will be via the pin connected to SW3. Click

the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select
‘Single Scan Mode S12AD’ as shown in Figure 4-39 then click ‘Next'.

MNew Component

Software Component Selection tlj-

Select component from those available in list

Type Drivers ~
Function | All v
Filter |
=

Components Type Version ()

8 Real Time Clock Code Generator 1.4.0

8 SCI/SCIF Asynchronous Mode Code Generator 1.6.0

£ SCI/SCIF Clock Synchronous M... Code Generator 1.6.0

£ Single Scan Mode 512AD Code Generator 1.8.0 |

B Smart Card Interface Mode Code Generator 1.6.0

B SPI Clock Synchronous Mode Code Generator 160

8 5Pl Operation Mode Code Generator 1.6.0

F# Voltage Detection Circuit Code Generator 160

BWatchdUg Timer Code Generator 160 v

< >
Show only latest version

Description

This software component provides single scan mede configurations for 12-Bit A/D

Converter which the analog inputs arbitrarily selected are converted for only once in

ascending channel order.

Download more software components

Configure general settings...

@ < Back I Next > I I Einish I Cancel

Figure 4-39 Select Single Scan Mode S12AD

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘S12AD0’ as shown in Figure

4-40 below then click ‘Finish’.

MNew Component

Add new configuration for selected component |

Single Scan Mode 5124D
Configuration name: | Config_512AD0 |

Resource: 512AD0 ~

@ < Back Mext = Cancel

Figure 4-40 Select resource — S12AD0
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Configure S12AD0 as shown in Figure 4-41 and Figure 4-42. Ensure the ‘Analog input channel’ tick box for
ANO0O0O is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’. All other settings

remain at their defaults.

Components = e

type filter text

v [= Startup ~
w [= Generic
@& rbsp
v [= Drivers
v [= Interrupt
@ Config_ICU
v [= A/D Converter
& Config_512AD0
w [= I/0 Ports
& Config_PORT
w [ Communications
& Config_SCI6
& Config_SCI3
~ [= Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

Configure

~ Basic setting

Analog input mode setting
[[1Double trigger mode

Analog input channel setting

Eno00 [ Anoot [ Anoo2 [ AMOO3
[]AN00S []AN00S [ AN007

Conversion start trigger setting

[]ANDO4

Start trigger source EA/D conversion start trigger pin [

Interrupt setting

Enable AD conversion end interrupt (512AD1) Priority

 Advance setting
Add/Average AD value setting
[ anooo ANDDT ANDD2 AMNOD3
ANDDS ANDDE ANDDT
Self diagnosis setting
Mede Unused

ov

Disconnection detection assist setting
Charge setting Unused
2 ADCLE

Dedicated sample hold circuit channel setting

[ ano00 ANODT ANDD2
Data registers setting

Data placement Right-alignment
Automatic clearing
Conversion resolution 12-bit accuracy
Addition/Average mode select Addition mode

Addition count 1-time

‘Window function setting

(® Disable (O Enable

Window A/B operation setting

[[] Enable comparison window A

Window A comparison condition matched OR window B comparison candition matched

Level 15 (highest) ~

Disable automatic clearing

[ Enable comparison window B

ANDD4

Figure 4-41 Config_S12AD0 setting (1)
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4. Smart Configurator Using the CS+

A/D comparison A setting

Reference data Ofor comparison

Reference data 1 for cormparisan

Use comparator for ANDDD
Use comparator for ANDO1
Use comparator for ANDOZ
Use comparator for ANDOZ
Use comparator for ANDO4
Use comparator for ANDOS

Use comparator for ANDOG

Use comparator for ANDOT

A/D comparison B setting

Reference data Ofor cormparison

Reference data 1for comparisan

Compatisan B channel

Input sampling time setting

Dedicated sarmple and hald circuit

AMODD/ Self-diagnosis
AROOT
AMD0Z
AMD0Z
AMD04
AMNO05
AN00E
AMNOOT

Interrupt setting

Enable AD conversion compare interrupt A (S12CMPAI)

Group BL1 priority

0.4

Reference data 0 > A/D-converted value

Reference data 0 » A/D-converted value

Reference data 0 » A/D-converted value

Reference data 0 > A/D-converted value

Reference data 0 » A/D-converted value

Reference data 0 > A/D-converted value

Reference data 0 > A/D-converted value

Reference data 0 » A/D-converted value

Unused

Reference data 0 > A/D-converted value

(ps)

0.183 (us)

0.183
0.183
0.183
0.183
0.183
0.183

0.183

{us)
{us)
{ps)
{ps)
{ps)
(ps)
{ps)

(Total conversion time: 0.133us)

Level 15 (highest)

(ctual value:
(Actual value:
{ictual walue:
{hctual value:
(htual value:
(ctual value:
(etual value:
(ctual value:

fctual value:

: 0400)
:0.183)
: 0183
10183
10183
10183
10,183
20783
10183

Enable AD conversion compare interrupt B (S12CMPEI)

Figure 4-42 Config_S12AD0 setting (2)
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4.6 The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed at Pins page.

i"’;‘f} *SC_Tutorial.scfg &2

Pin configuration

Hardware Resource =] laz 6%
Type filter text
= Al .

#f Clock generator

ia_,_ Clock frequency accuracy measurement circuit
‘-4'; Operating mode control

‘,!; System control

‘-5'; On-chip emulator

fF Interrupt controller unit

v ia“_ Multi-function timer pulse unit 3

w MTUO
MTU1
MTU2
MTU3
MTU4
MTUS
MTUE
MTUT
MTUS

> F § N FE R

#

Pin Function Pin Number

Overview | Board | Clocks | Components Interrupts

Figure 4-43 The ‘Pins’ tabbed page

4.6.1 Change pin assignment of a software component

To change the pin assignment of a software component in Pin Function list. Click 52 to change view to show
by Software Components.

LS,} *SC_Tutorial.scfg &2
Pin configuration

Hardware Resource =] laz

Type filter text

Figure 4-44 Change view to show by Software Components
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Select the Config_ICU of software component. In the Pin Function list -> Assignment column, change the pin
assignment IRQ12 to P44, IRQ13 to P45. Ensure the ‘Enable’ tick box of IRQ12 and IRQ13 are checked, as
shown in Figure 4-45.

Software Components 5 |8, &  PinFunction ~d | t” _§ﬂ| B3 e
Type filter text type filter text All w
v i#: r_bsp Enabled  Function Assignment Pin Number Direction Remarks

n' r_bsp . .
- £ £
- ‘#_‘ Connpare Match Timer O IRCO Notass!gned Notass!gned MNeone
'. Canfig CMTD [ IRQ1 # Mot assigned # Not assigned MNone
W C f'g_CMT‘I O IRQ2 # Mot assigned # Not assigned MNone
onfi
W C f'g_CMTZ O IRQ3 # Mot assigned # Not assigned MNone
onfi
. 9- O IRC4 # Mot assigned # Mot assigned Mone
w o Interrupt Controller ” - - -
Tonfig1CU | IRQS # Mot assigned # Mot assigned MNone
#ﬂ:rt = O IRQ6 # Mot assigned # Not assigned MNone
v orts
- Canfig PORT O IRQ7 # Mot assigned # Not assigned MNone
onfi
& g- O IRC3 # Mot assigned # Not assigned MNone
~ % 5CI/SCIF Asynchronous Mode . -
=T Canfig SCI6 O IRQ9 # Mot assigned # Not assigned MNone
onfi
#_‘* g- O IRQ10 # Mot assigned # Not assigned MNone
~ 2o 5Pl Clock Synchronous Mode . -
> Config SCI O IRQ11 # Mot assigned # Not assigned MNone
%'; s g-M e S124D IRQ12 7 PAL/IRCT2/ANDCA ] 7 ca I
v ingle 5can Mode
= ch fia S12AD0 IRQ13 [Z_P45/IRQT3/AN00S ] 7 o I
onfi
& g- O IRC14 # Mot assigned # Not assigned MNone
O IRQ15 # Mot assigned # Not assigned MNone
O NMI # Mot assigned # Not assigned MNone
£ >
Pin Function Pin Number
Overview | Board | Clocks | Components | Pins | Interrupts
p P

Figure 4-45 Configure pin assignment - Config_ICU

Select the Config_SCI6 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD6 and TXD6 are checked and Assignment column of RXD6 is P01 and TXD6 is P00
as shown in Figure 4-46.

Software Components 5 |8, &  PinFunction ~d | t” _§ﬂ| B3 e

Type filter text type filter text All ~

v & orbsp

LR

Enabled  Function Assignment Pin Number Direction Remarks
n' r_bsp

CTSe# # Mot assigned # Not assigned MNone
RTS6# # Mot assigned # Not assigned MNone
RXD& L#_PO1/TMCID/RXDE/ SMISO6/SSCLE/SSIBCKO/CATLE... | # D5 |
SCKG # Mot assigned # Not assigned MNone
TXD6 L _PO0/TMRID/ TXDE/SMO5I6/SSDARAUDIO CLK/CA.. | # E3 0

v ﬁ; Compare Match Timer
w' Config_CMTO
w' Config_CMT1
' Config_CMT2
v ﬁ; Interrupt Controller
& Config_ICU
v ﬁ: Ports
& Config PORT
v ‘#-_ SCI/SCIF Asynchronous Mode
& Config_5CI6
~ % SPI Clock Synchronous Mode
& Config SCI3
v /% Single Scan Mode S124D
& Config_5124D0

BOoEOO

Pin Function Pin Number

Overview | Board | Clocks | Components | Pins | Interrupts

Figure 4-46 Configure pin assignment - Config_SCI6
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Select the Config_SCI8 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK8 and SMOSI8 are checked and Assignment column of SCK8 is PJO, SMOSI8 is PJ2
as shown in Figure 4-47.

Software Components 5 |8, &  PinFunction ~d | t” _§ﬂ| B3 e

Type filter text type filter text All ~

v i'!: r_bsp Enabled  Function Assignment Pin Number Direction Remarks

SCK8 LZ_PIO/MTIOCHB/SCKE/SSLC1-B/EPLSOUTO/CATSYN... | # M3 10
SMISO8 # Mot assigned # Mot assigned Mone
SMOSI3 L PJlf'CLKOUTZ?Ma’TXDSa’SMOSI_Sa'SSDASa’SSLC3-Ba’L...| 716 10
558& # Mot assigned # Not assigned MNone

n' r_bsp

v ﬁ; Compare Match Timer
u' Config_CMTO
w' Config_CMT1
' Config_CMT2
v ﬁ; Interrupt Controller
& Config_ICU
v ﬁ: Ports
& Config PORT
w ‘-5‘-'_ SCI/SCIF Asynchronous Mode
& Config SCI6
v ﬁ; 5PI Clock Synchronous Mode
i Config_5CI3
v /%, Single Scan Mode 512AD
& Config_5124D0

OROE

Pin Function Pin Number

Overview | Board | Clocks | Components | Pins | Interrupts

Figure 4-47 Configure pin assignment - Config_SCI8

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of ADTRGO#, AN00OO, AVCCO, AVSS0, VREFHO and VREFLO are checked and Assignment
column of ANOOO is P40, ADTRGO# is PO7 as shown in Figure 4-48.

Software Components 5 |8, &  PinFunction ~d | t” _§ﬂ| B3 e
Type filter text type filter text All w
v i#: r_bsp Enabled  Function Assignment Pin Number Direction Remarks

uorb
=P . ADTRGOS 7 PUI/IROT5/ADTRGEE ]7 &5 |
v % Compare Match Timer
™ & Confio CMTO ANOOD [[7_P40/IRO8/AND0D ] 7 D4 I
onti
W C f'g_CMT‘I O AMDDT # Mot assigned # Mot assigned Mone
onfi
W C f'g_CMTZ O ANODZ # Mot assigned # Not assigned MNone
onfi
9- O ANDD3 # Mot assigned # Not assigned MNone
~ % Interrupt Controller . -
- Confia ICU | ANOD4 # Mot assigned # Mot assigned Mone
#-:'rt g- O ANDOS # Mot assigned # Not assigned MNone
v orts
- Canfig PORT O ANODE # Mot assigned # Not assigned MNone
onfi
#—u:'CI'SCIF,gQ_ h Mod O ANODT # Mot assigned # Mot assigned Mone
Vo 2 Asyneanous Mode AVCCO 7 ACCD 7 B2 [
Cenfig_5CI6
Pl AVSSD 7_AVSSD 7 Bl [
~ 2o 5Pl Clock Synchronous Mode VREFHO T VREFTD 7 a2 |
& Config_5CI8 = ”
~ . Single Scan Mode 512AD VREFLO < JRERLD 783 !
i Config_512AD0
£ >

Pin Function Pin Number

Overview | Board | Clocks | Components | Pins | Interrupts

Figure 4-48 Configure pin assignment - Config_S12AD0

Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘©lGenerate Code’ at location of Figure 4-49.

{8 SC_Tutorial.scfg 3% = =

Pin configuration

Figure 4-49 Generate Code Button
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If the Section Setting Dialog is displayed as shown in the Figure 4-50, Please check the box and click “Yes”.

Section Setting

-
I'\._.,- Do you want to change section setting?
Current section setting:

VECT/FFFFFF80,RESETVECT/FFFFFFFC
New section setting:

00,EXCEPTVECT/OxFFFFFF80, RESETVECT/OxFFFFFFFC
['Yes] to change section setting

[Mo] to keep current section setting
[Cancel] to cancel code generation

‘-I Current section setting of project may not be compatible with Smart Configurator

B_1,R_1,8.2,R_2,B,R B_8,R_8,5U,5//4,PResetPRG/FFCO0D00,C_1,C_2,C,C_B,CSDSEC,CSBS
EC, CSINIT, CSVTBL,CSVECT,D_1,D_2,0,D_8,P, PIntPRG,W_1,W_2, W, L/FFCD0100,EXCEPT

SU,SI,B_1,R_1,8_2,R_2,B,R B_8,R_§/0xD0000004,C_1,C_2,C,C_8,C8*, D% W L P*/0xFFCO00

The Console pane should report ‘Code generation is successful’, as shown Figure 4-51 below.

Dn not show again;

Yes Mo Cancel

Figure 4-50 Section Setting Dialog

& Console &2

Smart Configurator Qutput
Me4eeeeel: File generated:srcismc gen‘generallr

% bR MB-5-= 8

cg userdefine.h

MB4BBAAAL1: File generated:srcsmc gen‘pgenerallr

smc_entry.h

MB4000001: File generated:srclsmc gengenerallr

cg hardware setup.c

MB4800001: File generated:srcismc gen’generallr

cg cmt.h

MB4000001: File generated:srci\smc gen‘generallr

cg cmiw.h

Me4eeeeel: File generated:srcismc gen‘generallr

cg icu.h

MB4BBAAAL1: File generated:srcsmc gen‘pgenerallr

cg port.h

Me4000001: File generated:srcismc gengenerallr

cg s12ad.h

MB4BBBBAL: File generated:src\smc gen‘generallr

cg sci.h

Me4eeeeel: File generated:srcismc gen‘generallr

cg rspi.h

Maseaeal2: File
Maseeenlz: File
Maceeepaz: File
MB6826802: File
Me6e00002: File
Maeeeeea2: Code
Ma3eeenad: File

generated:srchsme gen'r pincfg\Pin.h

generated:srci\smc gen’\r pincfg\Pin.c

generated:src\smc gen‘generallr smc interrupt.c
generated:srchsme gen‘\general\r smc interrupt.h
generated:src\sme gen‘\r confighr bsp interrupt config.h
generation is successful

modified:src\sme gen\r confighr bsp config.h

-

Click the Save button shown in Figure 4-52 to save the Smart Configurator settings.

Figure 4-51 Smart Configurator console

After saving, close Smart Configurator and return to CS +.

File Window Help

& [E]

Figure 4-52 Saving Smart Configurator settings

When code generation is executed, the startup files generated at the time of CS+ project creation are
replaced with those generated by Smart Configurator. Figure 4-53 the project tree after code generation. In
the next chapter, user code is added to these files, and SC_Tutorial is completed by adding a new source file

to the project.

Project Tree . a2

¢ @ 2@

%
=

J Smart Configurator (Design Tool]
. A, CC-RX (Build Tool)
. RX Simulator (Debug Tool)
’\‘) Program Analyzer (Analyze Tool]
B:ﬂ File

'[EB Build tool generated files

‘ﬂ SC_Tutonal.c

=] '1 Smart Configurator
[ ] Config_chTo
[ ] Config_chT1
[ ] Config_CMT2
-] Config_IiCu
[ ]l Config_PORT
[l Config_5124D0
[ ]l Config_5CI6
-]} Config_SCi8
l_l general
-] r_bsp
J r_config

d r_pincfg

C Tutorial (Project)*
R5F372MMNDxBD (Microcontroller)

Figure 4-53 Smart Configurator folder structure
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5. Completing the Tutorial Project

5. Completing the Tutorial Project

5.1

Project Settings

e In the ‘Project Tree’ pane, select Project Tree P
‘CC-RX (Build Tooly. The build t 03 @
. . . . 3 . e
properties will appear in the main &=-L13 SC Tutorial (Project)”
. R3F572ZMMNDBD (Microcontroller)
W|ndOW. Smart Configurator (Design Tool)
22 RX Simulator (Debug Tool)
\“) Program Analyzer (Analyze Tool)
=30 File
e C(CS+ creates a single build | % ccRxProper
- . ‘ TR ~ Build Mode
configuration called ‘Default Build’ for Build mode
the project This has Standard Code . E?‘:Ungeprcperb,'va\uefcra\\bu\ld meodes at once No
opti misation tu r‘ned on by defau It Instrud‘\on set art.:hltecture ) o RXv3 architecture(isa=mcv 3}
Uses single-precision floating-point operation instructions Yesifpu)
Uses double-precision floating-point operation instructions Yesi-dpfpu)
Endian type for data Little-endian data{-endian=litle)
Rounding method for floating-point constant operations round to nearest({-tound=nearest)
Handling of denormalized numbers in floating-point constants Handles as zeros{-denomalize=off)
Precision of the double type and long double type Handles in single precision{-dbl_size=4)
Replaces the int type with the short type No
Sign of the char type Handles as unsigned char{-unsigned_char)
Sign of the bit-field type Handles as unsigned(-unsigned_bitfield)
Selects the enumeration type size automatically Mo
Order of bit-field members Allocates from right{-hit_order=right)
Build mode
Selects the build mode name 1o be used during build.
', Common Options | Compile Options AssembleOptions Link Options | Hex Output Options Library Generate
e Select the ‘Compile Options’ tab at | * CRYFroety
the bottom of the properties window
pane. Under ‘Language of the C st totpote Aktions il ptbel20)
la’ ¢ - = ’ System include paths System include paths[0]
source ﬂ le SeleCt ng( Iang 099) Iniludeﬂles at t:e head of compiling units Inyclude files aﬂEe head of compiling units[0]
as shown opposite. Macro definition Mecro definion(0]
Invalidates the predefined macro
Enables information-level message output MNolnomessage)
Suppresses the number of information-level messages
Undisplayed messages
Changes the warning-level messages to information-level messages No
Changes the information-level messages to warning-level messages No
Language of the C source file
Selects language of the C source file.
This corresponds to the -lang option of the compiler.
\, Commaon Options ;I Compile Options I{ AssembleOptions ,{’ Link Options ,( Hex Output Options ,( Library Generate (
[ ] SeleCt the ‘Link OptionS’ tab at the v x:nms;an address SU.SLB_1.R_1.B_2R_2B.RB_B.R _8/4.C_1.C_2.C.C_B.CS D W".L.P*/FFCO0000.|
b Ott om Of th e pr Op ertl es W| n d ow ';;sﬂ:eg:‘ﬂgend;e"?lon that cutputs externally defined sym gr;;isnp:;:\ge:m:eﬂ&mm outputs extemally defined symbols to the fie[0]
‘ ; 0 RAM mapped section
pane. Under ‘Section -> ROM to SRS ol R mappdsectent] =
. , Others
RAM mapped section’, add the three " 7
mappings as shown opposite. Soeciies FOM 1o RAN mapped seon in th ormat o *<ROM secon rames=<FAM secion ames o o e
This corresponds to the -rom option of the linker,
\_Common Options | Compile Options { AssembleOptions { Link Options || Hex Output Options Library Generate Options
e These settings are easily added by TR
clicking the button ‘..." and pasting
the following text into the dialog:
D=R
D _1=R_1
D 2=R 2
D 8=R_8
e This ensures that the linker assigns e =
RAM rather than ROM addresses to
C variables. Click ‘OK’
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e From the ‘Build’ menu, select ‘Build
Mode Settings.... Click ‘Duplicate’
and in the resulting ‘Character String
Input’ dialog, enter ‘Debug’ for the
name of the duplicate Build Mode.

@ 5C_Tutorial - C5+ for CC - [Property]

File Edit View Project|Build | Debug Tool Window Help

& st |1 H | g Build Project

gl

& & @ u:?] @ Rebuild Project
[0}|ProjectTree |
% ® 3 @ T2d| Repid Build
E‘,_.ﬁ SC Tutorial (B Update Dependencies

-4 RSFST2MMN 7
Smart Con

Clean Project

fenuegy vews £

=

'LI Build SC_Tuterial
] Rebuild SC_Tutorial
3
=4

g8 RX Simulat [} Clean SC_Tutorial
- Program 4 =¥ Update Dependencies of 5C_Tutorial

=3 File )| Set Link Order of SC_Tutorial...

L f] Build b

e smartd 2 500 Uil

‘ﬂ SC_Tut #1 Open the Cptimization Perfermance Comparisen Tool for SC_Tuterial..

F7
Shift+F7

Crl+F7

Ll ca
&[0 co T Build Mode Settings...

[ Il Cot £1 Batch Build..
m-L1 Co
m-L] co

T Build Option List

Build Mode Settings

Selected build mode:

Build mode list:

Default Build

Duplicate...

e The new ‘Debug’ Build Mode will be
added to the Build Mode list. Click
‘Close’.  Now, in the main CC-RX
Property  window, under  the
‘Common Options’ tab, click on the
line containing ‘Build Mode’, click the
pull-down arrow and select ‘Debug’
from the pull-down’.

A, CC-RX Property
~ Build Mode

Build mode Default Build

Change property value for all build modes at once
CPU

Instruction set architecture

Uses single-precision floating-point operation instructions
Uses double-precision floating-point operation instructions
Endizan type for data

Rounding method for floating-point constant operations
Hzndling of denormalized numbers in floating-point constants
Precision of the double type and long double type

Replaces the int type with the short type

Defautt Build

TRV ACTIECTOreT, 3T
Yes(fpu)

‘Yes(-dpfpu)

Little-endian datal-endian=litle)

round to nearest{+ound=nearest)
Handles as zeros|-denomalize=off)
Handles in single precision(-dbl_size=4)
Ne

Sign of the char type Handles as unsigned char(-unsigned_char)
Sign of the bit-field type Handles as unsignedi{-unsigned_bitfield)
Selects the enumeration type size automatically No
Order of bit-field members Allocates from right (bit_order=right)
Assumes the boundary alignment value for structure members is 1 Mof-unpack)
Build mode
Selects the build mode name to be used during build
'\.ICommon Optionsl,' Compile Options Assemble Options Link Options Hex Output Options Library Generate Options
‘ H g a (& -
* In the ‘Frequently Used Options (for | “ ccaxreee
H ’
Compile) group,  select the Bl mote Debug
. S . , . Change property value for all build modes at once No
Optimization Level’ option and select | |- B
‘“(y ?
0’ from the pull-down. We have NnOW | |+ ouputFiteTypeandPan
. y . . Output file type Execute Module{Load Module Fils)
created a Debug Build Mode with Intermediate file output folder “BuildModeName*.
. . . . ~ Frequently Used Options(for Compile)
no code optimisation and will be | | s mcise pars Addtiona inclde pathel20]
H H » System include paths System include paths[0]
using the Build Mode to create and | | e, e et
Outputs debugging information Yes(-debug)

debug the project.

Optimization level
QOutputs additional infermation for inter-module optimization
Optimization type

Outputs a source listfile

v Freq y Used Oy

2(-optimize=2)
[
1(-optimize=1)
2(-optimize=2)
Max(-optimize=max)
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All of the sample code projects
contained in this RSK+ are
configured with three Build Modes;
‘DefaultBuild’, ‘Debug’ and ‘Release’.
‘Release’ is created in the same way
as above; by duplicating ‘Default
Build’. ‘Release’ Build Mode leaves
code optimisation turned on and
removes debug information from the
output file.

To remove debug information from
the ‘Release’ Build Mode, in the ‘CC-
RX Property’ window, select the
‘Common Options’ tab at the bottom
of the window pane. For the
‘Outputs  debugging information’
option, select ‘No(-nodebug).

Reset the Build Mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.

From the menus, select ‘File -> Save
All' to save all project settings.

4, CC-RX Property a »p -
+ Build Mode
Build mode Release
Change property value for all build modes at ence Ne
CPU
PIC/PID
~ QutputFile Type and Path
Cutput file type Execute Module({Load Module File)
Intermediate file cutput folder %BuildModeMame %
v Fregquently Used Options(for Compile)
Additional include paths Additional include paths[11]
System include paths System include paths[0]
Macreo definition Macro definition[0]
QOutputs debugging information Yes(-debug)
Optimization level Z{optimize=2)
QOutputs additional information for inter-module optimization No
Optimization type Optimizes with emphasis on code size{size)
Outputs & source list file No(nolistfile)
Frequently Used Oplions{for Assemble)
v Frequently Used Options(for Link)
Using libraries Using libraries[0]
Yes (Outpus o the output e} DEBug) &

Optimization type
Section start address

+ Freguently Used Options{for Hex Output)

Yes (Outputs to the output file-DEBug)
Yes (Outputs to <output file name > dba filef-SDebug

No(-NODEBug)

Additional Folders

Before new source files are added to
the project, we will create two
additional folders in the CS+ Project
Tree.

In the Project Tree pane, right-click
the SC_Tutorial project and select
‘Add -> Add New Category’.

Project Tree

t © al@E

)

b ——
=Y
R3F572MMNDxB

Build SC_Tutorial

:.] Smart Configu m Rebuild SC_Tutorial
A, CC-RX (Build T _& Clean SC_Tutorial
i, R Simulator (]
T Program Anal 2_} Cpen Folder with Explorer
E:‘B File E Windows Explorer Menu
E1 Build tool ¢
Add L4 ,ﬁ Add Subproject...

‘ﬂ SC_Tutori

n_l Smart Con rf;

Set SC_Tutorial as Active Project

&3 Add Mew Subproject...

[#1 Save Project and Development Tools as Package... 1 AddFile..
4| Paste Cerl+V 9| Add New File...
8 Rename E2 1| Add New Category
Property
Rename the newly-created ‘New Project Tree oo
Category’ folder to ‘C Source Files’. &

Repeat these steps to create a new
category folder for ‘Dependencies’.

Z

@ 2@

= f§ SC Tutorial (Project)*

&3} File

- ﬂ Build tool generated files
&| SC_Tutorial.c
L] Smart Configurator

B Cs.ccvic

- QIE, R3F572MMDxBD (Microcontroller)
DJ Smart Configurator (Design Tool)
4, CC-RX (Build Tool)

25, RX Simulator (Debug Tool)

oo ’::' Program Analyzer (Analyze Tool)
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK+. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-ascii.c
-ascii.h
-r_okaya_lcd.c
-r_okaya_lcd.h
Copy these files into the C:\Workspace\SC_Tutorial\src folder and then follow the steps below.

« Move the ‘SC_Tutorial.c’ file from [ ] B - | sClutorial
‘C:\Workspace\SC_Tutorial’ to AR Home | share  View
‘C:\WOI’kSpace\SC Tutorial\SrC'. &« v P » ThisPC » Local Disk (C:) » Workspace » SC_Tutorial
Mame ) - Date n
3 Quick access R
Debug
[ This PC DefaultBuild
[ Desktop Release _A
. »
|z Documents =E
& Downloads ) dbsctc
J’ Music j hwsetup.c
o jintprg.c
= pfm"es " iodefine.h 5
B videos \j lowlvl.src 2
%5 Local Disk (C:) “Nowsre.c 1
= Network j lowsrc.h 2
j resetpro.c 2
j shrk.c 2/
1 shrk.h 2
\j SC_Tutorial A% =50 mtud 6/23/2
2192
&) sC_Tutorial.mtpj 6/22/2
« Select SC_Tutorial.c on the project tree, Right- P""“r - o
click and select 'Remove from Project to — —
. . =173 SC Tutorial (Project)”
exclude it from the project. # RSFS72MNDxBD (Microcontroller)
| Smart Configurator (Design Tool)
A, CC-RX (Build Tool)
e R Simulator (Debug Tool)
’\“) Program Analyzer (Analyze Tool)
- File
ﬂ Build tool generated files
g
- Smart Config Compile
3 Open
. Open with Intemal Editor...
[ Open with Selected Application...
i-:k Open Folder with Explorer
El Windows Explorer Menu
Add >
E_‘ Remove from Project Shift+Del
. . ‘ . y =3} File
» Right-click on the ‘C Source Files’ folder and "] Build tool generated files
select ‘Add’ -> ‘Add File...". L smart Configurator
t.[ ] Dependenci|  Add vl 3 AddFile..
Bl| Open Folder with Explorer 9| Add MNew File...
=) Windows Explorer Menu . \:l, Add New Category
2l Remove from Project Shift+Del
dy Copy Ctrl+C
15| Paste Ctrl+V
d@ Rename F2
Property
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« Select the files to be added (ascii.c,

\Workspace\SC_Tutorial\src.

r_okaya_lcd.c, SC_Tutorial) from C:

@ Add Existing File

- v

<« Workspace » SC_Tutorial » src »

v &) | Searchsrc
Organize « Mew folder
Mame
7 Quick access
smc_gen

& ThispC 7 ascii.c

[ Desktop j r_okaya_lcd.c

@ Documents H SC_Tutorial.c

¥ Downloads

D Music

&=| Pictures

B Videos

‘i Local Disk (C:)
=¥ Network

<

File name: | "SC_Tutorial.c” "ascii.c" "r_okaya_lcd.c" v| C source file (*.c)

Cancel

'Dependencies' folder.

« Similarly, add ‘ascii.h’ and ‘r_okaya_lcd.h’ to the

Note: Select the Header file (* .h; * hpp; * .inc).

@ Add Existing File

- v

<« Workspace » SC_Tutorial » src »

v &) | Searchsrc p
Organize ~ Mew folder m @
Mame
7 Quick access
smc_gen
B This PC " asciih
[ Desktop j r_okaya_lcd.h
[£ Documents
¥ Downloads
D Music
&=| Pictures
B Videos
‘i Local Disk (C:)
=¥ Network
< >
File name: ‘"r_nkaya_\(d.h" "asciih" v| IHeader file (*.h; *hpp; *.inc) VI

Cancel

screen shot.

« Make sure the project tree is the same as the

Project Tree o x

5 @ 8 [

=04 5C Tutorial (Project)”
£ R5F572MNDxED (Microcontraller)

. __j Smart Configurator (Design Tool)
4, CC-RX (Build Tool)
23 RX Simulator (Debug Tool)
' Program Analyzer (Analyze Tool)
=3} File
ﬂ Build tool generated files
‘EJ SC_Tutorial.c
-] Smart Configurator
[.][_E C Source Files
: ‘ﬂ ascii.c
‘fJ r_okaya_lcd.c
L.E] 5C_Tutorial.c
Q[E Dependencies
"J ascii.h
"_J r_okaya_lcd.h
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Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart
Configurator-generated code.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’ by double-clicking
on it. Add header files above the ‘main’ function as shown below.

#include "r smc_entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R LCD Display (0, (uint8 t *)" RSK+RX72M ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");
while (10U)

{

}

Indentation is lost when the code described in this manual is pasted into the CS+ source file. Also check that the
pasted code is correct.
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in §4.5.6. In
the CS+ Project Tree, expand the ‘Smart Configurator/Config_SCI8 and open the file ‘Config_SCI8.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI8 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */

Now, open the Config_SCI8_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t gs sci8 txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI8:
static void r Config SCI8 callback transmitend(void)
{
/* Start user code for r Config SCI8 callback transmitend. Do not edit comment generated here */

gs_sci8 txdone = TRUE;

/* End user code. Do not edit comment generated here */

}
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

J Rk Kk ok kA KRR A A K KAk k ok h ok kKA XA E Kk khhh kA AAA KA KA KKk k ok k ok kA XA KKK K&k kK kkkokkx

* Function Name: R_SCI8 SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments ¢ tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/

MD STATUS R_SCI8 SPIMasterTransmit (uint8 t * const tx buf,
const uintl6_t tx num)
{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
gs_sci8 txdone FALSE;

/* Send the data using the API */
status = R Config SCI8 SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == gs_sci8 txdone)
{
/* Wait */
}

return (status);

}

/*******************************************************************************

* End of function R SCI8 SPIMasterTransmit

R R R R R R R R R R R R R R R ]

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in §4.5.2. In the CS+ Project Tree,
expand the ‘Smart Configurator\Config_ CMTO\Config_ CMTO0.h’ and insert the following code in the user area
for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t gs one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config_ CMTO0_cmiO_interrupt function and insert the following line in the user code area:

static void r Config CMTO cmiO_ interrupt (void)
{
/* Start user code for r Config CMTO cmiO_interrupt. Do not edit comment generated here */

gs_one ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/****************************‘k**************************************************
* Function Name: R CMT MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds

* Arguments : uintl6 t millisecs, number of milliseconds to wait

* Return Value : None
****‘k*‘k‘k**‘k‘k**‘k‘k*‘k‘k‘k*‘k‘k‘k*‘k‘k‘k*‘k‘k‘k*‘k‘k‘k*‘k‘k‘k*‘k‘k************************************/
void R _CMT MsDelay (const uintlé t millisec)

{

uintlé t ms count = 0;

do
{
R Config CMTO Start();
while (FALSE == gs_one ms_delay complete)
{
/* Wait */
}
R Config CMTO Stop();
gs_one_ms_delay complete = FALSE;
ms_count++;
} while (ms_count < millisec);

}

KKK KK K kK K K K kK K K K kK K Kk kK R R R K R K R kK R R R kK R R R kK R R R kK R R R Rk R Rk Rk kK

End of function R CMT MsDelay
*******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The program will display ‘RSK+RX72M
Tutorial Press Any Switch’ on 3 lines in the LCD display.
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54 Switch Code Integration

API functions for user switch control are provided with the RSK+. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rskrx72mdef.h
-r_rsk_switch.c
-r_rsk_switch.h
Copy these files into the C:\Workspace\SC_Tutorial\src folder. Add these files into the project in the same way
as the LCD files as in section 5.3.

The switch code uses interrupt code in the files Config_ICU.c, Config_ICU_user.c and Config_ICU.h and timer
code in the files Config ICU.c, Config ICU_user.c, Config CMT1.h, Config_ CMT1.c, Config_ CMT1_user.c,
Config CMT2.h, Config CMT2.c, and Config CMT2 user.c, as described in §4.5.2 and §4.5.3. It is
necessary to provide additional user code in these files to implement the switch press/release detection and
de-bouncing required by the API functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Smart Configurator/Config_ICU’ folder and open the file ‘Config_ICU.R’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */
uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);
void R _ICU IRQSetRisingEdge (const uint8 t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */

Now, open the Config_ICU.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

[ KKk k ok ok ok kK K A A K Kk ko k k ok ok kR A A A K K K Kk ko ko ok ok ok kR AR A A K Kk ko ko ok ok ok kR R A A R K Kk ok kR ok ok ok ok ok

* Function Name: R_ICU IRQIsFallingEdge

* Description : This function returns 1 if the specified ICU _IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8 t irg no

* Return Value : 1 if falling edge triggered, 0 if not
*******************************************************************************/

uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no)

{
uint8 t falling edge trig = 0x0;

if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE FALLING)
{

falling edge trig = 1;
}

return (falling edge trig);

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k*********************************

* End of function R ICU IRQIsFallingEdge

LR EEEE RS S SRR EEE e AR EE AR EE Rt EEE Rt

R20UT4386EG0100 Rev. 1.00 :{EN ESNS Page 48 of 69
Jul.31.19



Renesas Starter Kit+ for RX72M 5. Completing the Tutorial Project

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* Function Name: R_ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
*******************************************************************************/

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set f edge)
{
ICU.IRQCR[irg no] .BYTE |= 04 ICU IRQ EDGE FALLING;

}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

}

VAR AR EEE RS SRR R Rt EEE R R R R R R

* End of function R ICU IRQSetFallingEdge

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***********************/

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* Function Name: R ICU IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

*

Return Value : None
*******************************************************************************/
void R ICU IRQSetRisingEdge (const uint8 t irqg no, const uint8 t set r edge)
{

if (1 == set_r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE RISING;
}
else
{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;
}
}

VAR AR EEE RS SRR R R AR R R R RSt e R R

* End of function R _ICU_IRQSetRisingEdge

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***********************/

/* End user code. Do not edit comment generated here */
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Open the Config_ICU_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg13_interrupt:

/* Start user code for r Config ICU irgl3 interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg12_interrupt:

/* Start user code for r Config ICU irgl2 interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */
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5.4.2 De-bounce Timer Code

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT1’ folder and open the ‘Config_ CMT1_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the ‘Config_ CMT1_user.c’ file insert the following code in the user code area inside the function
r_Config_ CMT1_cmi1_interrupt:
/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT2’ folder and open the ‘Config_ CMT2_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

Open the ‘Config CMT2_user.c’ file and insert the following code in the user code area inside the function
r_Config_ CMT2_cmi2_interrupt:

/* Start user code for r Config CMT2 cmi2 interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT2 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */
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543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In §4.5.7 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */

extern volatile uint8_t g_adc_trigger;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘C Source Files’ folder and Open the file ‘SC_Tutorial.c’ and add the
highlighted code, resulting in the code shown below:

#include "r smc entry.h"
finclude "r okaya lcd.h"
#include "r cg userdefine.h"

#include "Config S12ADO.h"
#include "r rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the

code shown below:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Tnit();

/* Set the call back function when SWl1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX72M ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0_Start();

while (10U)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R_Config S12AD0_Get_ ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

}

Then add the definition for the switch call-back, get_adc and lcd_display_adc functions adding at the below of

the main function, as shown below:

/******************************************************************************

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument : none

* Return value : none

******************************************************************************/

static void cb_switch press (void)

{
/* Check if switch 1 or 2 was pressed */
if (g_switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))
{
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/* set the flag indicating a user requested A/D conversion is required */

g_adc_trigger = TRUE;

/* Clear flag */
g_switch flag = 0x0;
}
}

/******************************************************************************
* End of function cb switch press

******************************************************************************/
/******************************************************************************

* Function Name : get adc

* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.

* Argument : none

* Return value : uintl6 t adc value

~k*~k********~k**********J(J(~k~k9(9(9(J(J(J(J(9(9(9(~k9(J(J(J(J(9(9(9(~k9(J(J(J(J(9(9(9(J(J(**********************/
static uintl6é t get adc (void)

/* A variable to retrieve the adc result */
uintlé t adc result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12AD0 Stop();

/* Start a conversion */
R_S12AD0O_SWTriggerStart () ;

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)
{
/* Wait */
}

/* Stop conversion */
R_S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g_adc_complete = FALSE;

R Config S12AD0 Get ValueResult (ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R Config S12AD0 Start();

return (adc_result);

}

/******************************************************************************

* End of function get adc
******************************************************************************/

/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6é_t adc result

* Return value : none

‘k‘k‘k‘k**************************************************************************/
static void lcd display adc (const uintlé_t adc_result)
{

/* Declare a temporary variable */

uint8_t a;

/* Declare temporary character string */
char lcd buffer[11l] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8 t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t) ((adc_result & 0x00F0) >> 4);
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lcd buffer[7] = (char) ((a < 0x0A) 2 (a + 0x30) : (a + 0x37));
a = (uint8_t) (adc_result & 0xO000F);
lcd buffer[8] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd buffer */
R_LCD Display(3, (uint8 t *)lcd buffer);

}

/******************************************************************************

* End of function lcd display adc
******************************************************************************/

In the Project Tree, expand the ‘Smart Configurator\Config_S12AD0’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R S12AD0 SWTriggerStart (void);
void R S12AD0 SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_S12ADO0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R S12AD0 SWTriggerStart
* Description : This function starts the ADO converter.
* Arguments : None
* Return Value : None
*******************************************************************************/
void R_S12AD0_SWTriggerStart (void)
{

IR(PERIB, INTB186) = 0U;

IEN (PERIB, INTB186) = 1U;

S12AD.ADCSR.BIT.ADST = 1U;
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

End of function R S12AD0_ SWTriggerStart

*******************************************************************************/

/*******************************************************************************
* Function Name: R _S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None
* Return Value : None
*******************************************************************************/
void R _S12AD0 SWTriggerStop (void)
{

S12AD.ADCSR.BIT.ADST = 0U;

IEN (PERIB, INTB186) = 0U;

IR (PERIB, INTB186) = 0U;
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

End of function R S12AD0 SWTriggerStop

*******************************************************************************/

/* End user code. Do not edit comment generated here */
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Open the file Config_S12AD0_user.c and insert the following code in the user code area for global, resulting in
the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0_interrupt function, resulting in the
code shown below:

static void r_ Config S12AD0_interrupt (void)
{

/* Start user code for r Config S12AD0O_interrupt. Do not edit comment generated here */

g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

}
Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
The project may now be run using the debugger as described in §6. When any switch is pressed, the

program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the SC_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK+ serial port are provided with the RSK+. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

-r_rsk_debug.c

-r_rsk_debug.h
Copy these files into the C:\Workspace\SC_Tutorial\src folder. Add these files into the project in the same way
as the LCD files as in section 5.3.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R _SCI6 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Smart Configurator\Config_ SCI6’ folder and open the file ‘Config_SCI6.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R _SCI6 AsyncTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI6_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t gs sci6_ txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI6_callback_transmitend function:

static void r Config SCI6 callback transmitend (void)
{
/* Start user code for r Config SCI6 callback transmitend. Do not edit comment generated here */

gs_sci6_ txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area
inside the r_Config_SCI6_callback_receiveend function:

static void

{

/* Start

r Config SCI6 callback receiveend(void)

/* Check the contents of g rx char */

if (('c'
{

== g _rx char) || ('C' == g _rx char))

g_adc_trigger = TRUE;

}

/* Set up SCI6 receive buffer and callback function again */
R Config SCI6 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/‘k‘k‘k‘k‘k‘k*************************************************************************

*

buffer size

* Function Name: R _SCI6_ AsyncTransmit

* Description : This function sends SCI6 data and waits for the transmit end flag.
* Arguments tx buf -

* transfer buffer pointer

* tx_num -

*

*

Return Value : status -

MD OK or MD ARGERROR

***********************:********:**********************************************/

MD_STATUS R_SCI6_AsyncTransmit (uint8 t * const tx _buf, const uintl6_t tx_ num)

{

MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
gs_sci6_txdone = FALSE;

/* Send

the data using the API */

status = R Config SCI6 Serial Send(tx buf, tx num);

/* Wait

for the transmit end flag */

while (FALSE == gs_sci6_txdone)

{

/* Wait */

}

return

}

(status) ;

/*******************************************************************************

* End of function R SCI6 AsyncTransmit

KKK KKK KKK K K KK kK R K K K R R R K R R R K K R R R o K R R R R K R R R kR R R R Rk kR R Rk Rk R R R kR Rk /

user code for r Config SCI6 callback receiveend. Do not edit comment generated here */
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5.6.2 Main UART code

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following

declaration to above the ‘main’ function:

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI6.h"

/* Variable for flagging user requested ADC conversion */

volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */

static void lcd display adc (const uintlé_t adc_result);

/* Prototype declaration for uart display adc */

static void uart display adc(const uint8 t gs_adc count, const uintlé t adc result);

/* Variable to store the A/D conversion count for user display */

static uint8 t gs_adc count = 0;

Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R_SWITCH TInit();

/* Set the call back function when SW1l or SW2 is pressed */

R_SWITCH_ SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R LCD_Init();

/* Displays the application name on the debug LCD */

R_LCD Display (0, (uint8 t *)" RSK+RX72M ");
R_LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI6 receive buffer and callback function */
R Config SCI6_Serial Receive((uint8 t *)&g rx char,

/* Enable SCI6 operations */
R Config SCI6_Start();

while (10U)
{

uintlé t adc result;

/* Wait for user requested A/D conversion flag to be set

if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the gs adc_count */
if (16 == (++gs_adc_count))
{

gs_adc_count = 0;

}

/* Send the result to the UART */

(SW1 or SW2)
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uart display adc(gs_adc_count, adc_result);

/* Reset the flag */

g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc complete)
{

/* Get the result of the A/D conversion */
R Config S12AD0_Get ValueResult (ADCHANNELO, &adc result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the gs adc count */
if (16 == (++gs_adc_count))
{

gs_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(gs_adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}

else
{

/* do nothing */
}

Then, add the following function definition in the end of the file:

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k********************************************************

* Function Name : uart display adc

* Description : Converts adc result to a string and sends it to the UARTI1.
* Argument : uint8 t : gs_adc count

* uintlé_t: adc result

* Return value : none

******************************************************************************/
static void uart display adc (const uint8 t gs adc count, const uintl6 t adc result)
{

/* Declare a temporary variable */

char a;

/* Declare temporary character string */
static char uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char) (gs_adc_count & 0x000F) ;

uart buffer[4] = (char) ((a < 0xO0A) ? (a + 0x30) : (a + 0x37));
a = (char) ((adc_result & 0xOF00) >> 8);

uart buffer([14] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) ((adc_result & 0x00F0) >> 4);

uart buffer[15] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) (adc_result & 0x000F);

uart buffer[16] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R _DEBUG_Print (uart buffer);

VAR AR EEE RS SR EEE R AR R R R R RS R R

* End of function uart display adc
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
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The project may now be run using the debugger as described in §6. Connect the RSK+ G1CUSBO port to a
USB port on a PC. If this is the first time the RSK+ has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &
LPT)" as 'RSK+ USB Serial Port (COMx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI6 (Baud Rate:
19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).

When any switch is pressed, or when ‘¢’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the SCI6.

5.7 LED Code Integration

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to the above the ‘main’ function:

#include "r smc entry.h
#include "r okaya lc
#include "r cg
#include "Confi
#include "r rs
#include "r rsk
#include "Config SCI6.h"
#include "rskrx72mdef.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t gs adc count, const uintl6 t adc_ result);

/* Variable to store the A/D conversion count for user display */
static uint8_ t gs_adc_count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)" RSK+RX72M ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();
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/* Set up SCI6 receive buffer and callback function */
R Config SCI6 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI6 operations */
R _Config SCI6_Start();

while

{

(10)

uintlé_t adc result;

/* Wait for user requested A/D conversion flag to be set

if
{

}

/* SW3 is directly wired into the ADTRGOn pin so will

(TRUE == g_adc_trigger)

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display_ adc(adc_result);

(SW1 or SW2)

/* Increment the gs_adc_count and display using the LEDs */

if (16 == (++gs_adc_count))
{

gs_adc_count = 0;
}

led display count (gs_adc_count);

/* Send the result to the UART */

uart display adc(gs_adc_count, adc result);
/* Reset the flag */

g_adc_trigger = FALSE;

cause the interrupt to fire */

else if (TRUE == g _adc_complete)

{

}

/* Get the result of the A/D conversion */

R Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the gs adc_count and display using the LEDs */

if (16 == (++gs_adc_count))
{

gs_adc_count = 0;
}

led display count (gs_adc_count);

/* Send the result to the UART */

uart _display adc(gs_adc_count, adc_result);
/* Reset the flag */

g_adc_complete = FALSE;

else

{
}

/* do nothing */

*/
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Then, add the following function definition at the end of the file:

/******************************************************************************

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDS0-3
* Argument : uint8 t count

* Return value : none

LR EEEE RS SRR R AR R R Rt EE R

static void led display count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8_t) ((count & 0x01l) ? LED ON : LED OFF);
LED1l = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8_t) ((count & 0x04) ? LED ON : LED OFF);
LED3 = (uint8_t) ((count & 0x08) ? LED ON : LED OFF);

}

/**************************************~k***************************************

* End of function led display count
Ak hkhkhkhkhkhkhkhkhkhk Ak hkhkhkhk bk hk ok hk ko bk hk ok hk ko hhk ok hk ko hkhkh ok hhkhkhkhkhhk ok hhkhkkhkhkhkhhkhkhhkhkdkhkhkhkhkkhkhkhkhkkkhkkhkkkkk

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The code will perform the same but now

the LEDs will display the gs_adc_count in binary form.
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6.

Debugging the Project

e In the ‘Project Tree’ pane, right-click the | lEEEEEEE 1 x
‘RX Simulator (Debug Tool). Select | ¢ @ & [&
‘Using Debug Tool -> RX E2 Lite’. =L SC Tutorial (Project)*
3:% R3F372MMNDxBD (Microcontroller)
| Smart Configurater (Design Tool)
4,, CC-RX (Build Tool)
B Simstor (Debug Tooll
T) Program Analyzer (Analyz Using Debug Tool >| R¥ E2
=@ fle 7 Property [ RXE2Lite
b ﬂ Build tool generated f -
|_l Smart Configurator RX E1(Serial)
- C Source Files RX E1(JTAG)
|_l Dependencies RX E20(Serial)
RX E20(JTAG)
RX Simulator
e Double-click ‘RX E2 Lite (Debug Tool)’ to | |FF Froperty
display ‘ the ’debugger tool pr_opert|es. S\ FXE2 ke Property
Under ‘Clock’, change the main  clock | 1 jniermal ROWRAM
frequency to 24MHz, Communications Size of internal ROMKBytes] G
method ‘JTAG’ and operating frequency to Size of internal RAM[KBytes] 1064
, Size of DataFlash memory[KEytes] 32
240MHz. v Clock
. . . Main clock source EXTAL
e All other settings can remain at their Main clock frequency[MHz] 24,0000
defaults. Operating frequency[MHz] 240.0000
Allow changing of the clock source on writing internal flash memory No
w Connection with Emulator
Emulator serial No.
+w Connection with Target Board
Power target from the emulator. (MAX 200md) No
Communications method JTAG
e Connect the E2 Lite to the PC and the
RSK+ E1/E2 Lite connector. Connect the
Pmod LCD to the PMOD1 connector.
e From the ‘Debug’ menu select ‘Download’
to start the debug session and download
code to the target.
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7. Running the Smart Configurator Tutorial

71 Running the Tutorial

Once the program has been downloaded onto the RSK+ device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

®
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8. Additional Information

Technical Support
For details on how to use CS+, refer to the help Window | Help |
file by opening CS+, then selecting Help > Help R |® Help
Contents from the menu bar. S-S

1: (@S 9

). Open Help for Main window F1

How to Access Help »
@;‘ Cne Point Advice...
B Tutorial
@] Browse Renesas Electronics Microcontrollers Web
2@ Privacy Settings...
(i Detail Versicn Infermation...

@Y Lsunch License Manager...

(3 About...

For information about the RX72M group microcontroller refer to the RX72M Group Hardware Manual.
For information about the RX assembly language, refer to the RX Family Software Manual.
Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of

this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe GmbH.

© 2019 Renesas Electronics Europe GmbH. All rights reserved.
© 2019 Renesas Electronics Corporation. All rights reserved.
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